Installation and Quick Start of
ISYSTEM's winIDEA Open
in DAVE™

Tutorial
Version 1.0, May, 2014

(infineon



Infineon

i

About winIDEA Open

B iISYSYTEM provides a free version of its debugger IDE called
winIDEA Open; it can use the Segger J-Link SW and J-Link HW to
connect to the MCU target

O Debugger in a proprietary IDE plus the ARM GCC

O Eclipse plug-in to use the CDT debug perspective or the
proprietary IDE

M The eclipse plug-in can be installed in DAVE to extend the debug
capabilities of DAVE

B The winIDEA Open Debug IDE provides extended functionalities
beyond the default DAVE debugger:

O Real-time period update and graphical display of variables while
the target MCU is running

O RTOS Kernel aware debug e.g. FreeRTOS
O Integrated unit test tool (without code instrumentation)
O Process automation and integration, scripting (isystem.connect)



http://www.isystem.com/download/winideaopen
http://www.isystem.com/download/eclipse
http://www.isystem.com/download/eclipse
http://www.isystem.com/download/eclipse
http://www.isystem.com/download/eclipse
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Content of this Tutorial

B This tutorial provides a step by step description to

O Install the winIDEA Open eclipse plug-in into DAVE

O Create a very simple project for the XMC2 Go kit
— Generation of a low frequency PWM signal using DAVE Apps to toggle a LED

O Set up the debug configuration in DAVE to use winIDEA Open with the
CDT debug perspective in DAVE

O Set up the debug configuration in DAVE to use the winIDEA Open in its
proprietary IDE started from DAVE

B Prerequisites

O DAVE v3.1.10 or later should be installed
— Including the latest version of the DAVE Apps libraries
O Segger J-Link SW v4.80f or higher should be installed

O XMC2 Go kit (or any other XMC kit with J-Link OBD)
— If a different XMC kit is used the device selection (page 8) and the selected
output pin for the PWM signal (page 1) may be different

— If a XMC kit without J-Link OBD is used a separate J-Link debugger e.g. J-Link
Lite is required



Installation of the winIDEA Open eclipse plug-in . —

into DAVE (1) (afineon.

1. mem)
DAVE Debu ~ | Hel .
B wop | |Wekome Press in DAVE:

/_@ Help Contents ->He|p ->InSta|| NeW SOftware.
7%

¢ | B% 0|19 Search

b=
|

Dynamic Help

2 Press ->Add in “Work with”.

Key Assist... Ctrl+Shift+L
Tips and Tricks...

DAVE™ Forum

DAVE™ Online Support

Report Bug or Enhancement...

Cheat Sheets...

e

3 Enter any name, here,
“iSystemWinIDEAopen” is used.

Install DAVE Apps/Example Library
Check for DAVE App Updates
Uninstall DAVE App/Example Library
Check for Updates

Install New Software... I

=

4 Copy in “Location” the below
shown http link.

http://www.isystem.si/eclipseUpdate/debuggerHelios36

SRR RS = =

About DAVE 3
HOEFINE VADU GO CCVADC_|

i sl e R T~ T s <
Available Software ’_J_ 5 Press -> O K

Select a site or enter the location of a site. \f)l‘

2

Work with: type or select a site - Add...

Find more software by working with the "Available Software Sites” preferences.

type filter text | & Ad~ "enository ﬂ

=

Name

[ ]® There is no site selectef | Name.— iSytemWinIDEA_open

Location: http://www.isystem.si/eclipseUpdate/debuggerHelios36 Archive...

4
® 5 [ OK ] l Cancel ]

\

SelectAll | | DeselectAll |
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Installation of the winIDEA Open
plug-in into DAVE (II)

o Install o e N o = e

Available Software
Check the items that you wish to install. o
Work with: IDEA_open - http://fwww.isystem.si/eclipseUpdate/debuggerHelios36 + Add..

Find more software by working with the "Available Software Sites” preferences.

type filter text

Mame Version
4 UUU iSystem Debugging
@ iSystem Debug Caore 1.0.152.i9_12_145_Indigo_37_35774
1 @ iSystem Debugger 1.0.152.i9_12_145_Indigo_37_35774
| selectAll | [ DeselectAll 2 items selected
Details

»

Show only the latest versions of available software [ | Hide items that are already installed
Group items by category What is already installed?
[] Show only software applicable to target environment

Contact all update sites during install to find required software

http://www.isystem.si/eclipseUpdate/debuggerHelios36

eclipse

Select iSystem plug-in.

Press ->Next.

Then follow the further
instructions, accept the
terms of use and restart
DAVE after successful
installation of the plug-in.
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Installation of the winIDEA Open debug (iﬁneon

engine and IDE

Press in DAVE ->Window ->Preferences ->iSystem 1
Then the below user interface will appear.

W Preferences =] DS
type filter text Eed iSystem (=T 4 v -
General
C/C++ Select the desire 1 JEA setu
Dave @ winIDEA Open Install/Update
Help ©) winIDEA:
Install/Update winIDEA installations
ISystem : : .
Use latest version [Not available]
Java
Mylyn Use this version: |---- Select installed winIDEA version ---- hd
]
Downloading winIDEA Open - — i Browse...
MV
I SYSTEM winIDEA
You are currently using winIDEA OPEN. For regular winlDEA please visit? __________
m |
Download progress: 6599kB of 195539kB (3%)
@ [ OK ] ’ Cancel

2014-05-02 Copyright © Infineon Technologies AG 2014. All rights reserved.

Press ->Install/Update.

Then the installation control
of winIDEA open will appear.

Follow/ accept subsequent
installation prompts.

The winIDEA open debugger
engine and IDE is then
installed in the eclipse
folder of the the DAVE
installation.

> L. ARM-GCC

> | CMSIS

> ). Debugger
| Doxygen

4 | eclipse

> | configuration
> | features
4 | iSystem
4 | winlDEAOpen
| configuration
> | daqgIlDEA
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Create a very simple project for the XMC2 Go kit

(1)

We will now generate as simple project using a PWM App to blink one of the LEDs of the

XMC 2Go kit with the frequency of the PWM signal.

1  DAVEIDE-DAVES3 1
File Edit Navigate Search Project DAVE Debug Window Help
i | B1 g1 @ » JE#NS @ o vl 0
F — > . — = =
[ |
= 2
DAVE Project

Create a new C/C++ project for Infineon tool chains

Project Name: XMC_2GID_PWM

Use default location
Location: | Dif/GH_SW_Projects/DAVE3/dave3110/WS7_isystem Br 4

Ml Project Type: Tool Chain:
= Infineon XMC i ARM-GCC Application for XMC
= ARM-GCC Application for XMC Project
Easy Start Project
Empty Main Project =
2 DAVE CE Project
Empty Project
= ARM-GCC Library for XMC Project
Empty Project hd

Show project types and tool chains only if they are supported on the platform

4
@ < Back l Mext = I Finish Canc

Press in DAVE:
-> File ->New ->DAVE Project.

Select "DAVE CE Project”.

Enter a project name, here:
XMC_2GO_PWM

Press -> Next.

2014-05-02 Copyright © Infineon Technologies AG 2014. All rights reserved.
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Create a very simple project for the XMC2 Go kit

(1I)

Target Selection Page

Select the controller for which the project has to be created

4[| XMC1100 Series
[ | xMC1100-Q040F0064
[ XMC1100-Q040F0032
[ XMC1100-Q040F0016
[ ] xMC1100-T038X0064
|| xmc1100-To38F0064
|| xmc1100-To38F0032
1 [ |xmc1100-To38F0016
XMC1100-Q024F0064
[ ] xMC1100-Q024F0032
|| xmc1100-Q024F0016
—=1... nn o ernaon

Device Features
Package= PG-VQFN-24
ROM= 64 KB Flash
RAM= 16 KB RAM
InOut= 22 digital [/O

Further Options

Start up file preferences
Add/Update start up files

2
1 Select the XMC1100 Q024F0064

If a different board is used select the
appropriate target MCU

2 Press -> Finish

2014-05-02 Copyright © Infineon Technologies AG 2014. All rights reserved.
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File Edit Source Refactor MNavigate Sear
3~ | W G [ B ®
(&) (2| (K] E)| coM Pport |[cOM7 ~ |

B2 C/C++ Pr 22 [y ProjectEx| = O

| ER Y

4 == XMC_2GO_PWM [ Active - Debug

> ! Includes

: (= Dave

» = Lib

: (= Startup

> [€ Main.c

5 XMC_2GO_PWM.Id

] 1l 3

Finally a new project has been added
into the workspace.

The project includes a very simple
main.c that calls the DAVE init
function, the target specific startup
files and linker script file and the
stubs for the c library.
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Adding and configuring a PWM App to @
generate the required PWM signal

«a App Selection View = =B 1 : : : n "
| o 5 Enter in App Selection View of DAVE “"PWM".
Search filter PWM|
t 2 Double click on PWMSPO0O1 to add this DAVE App to the project
Category Based Tree . ey . .
= Time Processing % Then this App plus additional required Apps can be seen in the
& PWM Generation S/W App Connectivity View.! 3
«a PWMSPOO1 [1.0.32]
«n PWMSP0O03 [1.0.8] = ||
B;ef;?r:ee:a_'ciif:::fcﬂsare ' 4 Double Click on the PWMSP00O1 App to open the configuration GUI.
= Capture/Compare Unit 4 (CAP_ &
o0 108 h 5 (6 (7 Change the marked settings in the configuration GUI.
< | 1 3

Show Latest Versions Only

== PWMSP001 0 2
Timer Mode Settings
Counting Mode Timer Mode 5 Start
@ Edge-Aligned Mode [ Enable Single Shot Mode Start during initialization
() Center-Aligned Mode

sn S/W App Cunnectivity View &2 . ga H/W Conne

4 wa PWMSP0O01/0
Timer Con’ 6 Ins

CCUA4 resoluuon | 32000 nsec - 32000 nsec - s CCU4GLOBAL/0
PWt 7 2 Hz - 3d08 hex =
Duty Cycle | 50| % - 1e84 hex h «e CLK0D02/0

No timer concatenation

Interrupts
Compare Match Period Match External Start
"] Enable at initialization ["]Enable at initialization ["] Enable at initialization
External Stop Trap Interrupt

2014-05-02 Copyright © Infineon Technologies AG 2014. All rights reserved. Page 9



Assign the PWM signal to the required pin

Gafineon

DAVE provides a resource solver to map the appropriate chip resources to the DAVE Apps. To make sure that the
PWM signal will be generated at the pin where the LED is connected we need to assign the required pin manually
as constrain for the solver.

= S/W App Connectivity View &2

1 1., pwmspoor

ss CCU4GLOBA

2

sa CLKOO2/0

UIEditor
Remove

Signal Connection

Manual Pin Assignment |

Manual Resource Assignment

Add User Label

«s H/W Connectivity View | E

1 Right mouse click on the PWMSP0O01 App.

2 Select “Manual Pin Assignment”.

3 Select “pin_directoutput”.

4  Select “P1.0/#14".

5 Press ->Solve And Save.

2014-05-02

Properties
& Manual Pin Assignment l = (=] ﬂ
| Filter PWMSPO01/0 ~ |
App Resource Paort-Pin/Pin Number

(S PWMSP001/0 3 4 —
pin_directoutput v Pl.D [ #14 v I

Mot Selected + Mot Selected -
I Solve And Save Il Reset l l Close 7

—r———————

Copyright © Infineon Technologies AG 2014. All rights reserved.

If a different board than the
XMC2 Go kit is used a
different pin has to be
assigned.

6 Press ->Close.
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Generation of the PWM library, compilation, @
and creating a new debug configuration

Egm= @l oo

Generate Code

il |l T
| || ( Renuu]d,f;.ctive_r"rojehct Ea'
BE C/C++ Pr 2~ [y Project Ex| — O || am PWh
| = <~1='=f> = Timetr

3
I f_& - % - = {)'-' - gﬁ [
Debug Configurations...

w Debug Cunﬁgurations‘ L R e -

Create, manage, and run configurations

B3~ Configure laut

- Press the 'N¢

. _[E] FX GDB Debuggin £ - Press the
4 ¥ iSystem Debugger
- Press the
A TASKRING U/CF+ Deblgager

- Press the

x

i&i

L

1 Press “Generate Code”.

2 Press “Rebuild Active Project”
Click on the project name in the workspace.

3 Press the combo box of "Debug Configuration”.

4 Double Click on “iSystem Debugger” to create a new
debug configuration.

Notes:

= We don’t need to add any user code to call any PWM
library function because main.c contains already a
call of the DAVE init function which start the PWM
signal with 2 Hz according to our configuration (page
9).

= Before we execute step3 it is important to select the
project (click on the project name), otherwise the
debug configuration will not be created with the
correct project information (winIDEA does not use the
active project functionality to determine the project).

2014-05-02 Copyright © Infineon Technologies AG 2014. All rights reserved. Page 11



Correct setup of the debug configuration

w Debug Configurations

Create, manage, and run configurations

iSystem Debug Launcher

R

Name: XMC_2G 2 ebug

[El Main ?&iSystem Debugger| % Source " Refresh = Arguments | P8 Environment
C/C++ Application:
[

type filter text
[E] IFX GDB Debugging
4 % iSystem Debugger
& XMC_2GO_PWM Debu
#= TASKING C/C++ Debugg

Debug\XMC_2GO_PWM.elf
Project:

XMC_2GO_PWM

Build (if required) before launching

Build configuration: Debug

Select configuration using 'C/C++ App
() Enable auto build (7) Disable auto build

(@ Use workspace settings Configure Workspace Sett

Connect process input & output to a terminal.

MName: XMC_2G0O_PWM Debug

Main | %5 iSystem Debugger . % Source| " Refresh| ¢ Arguments| B8 Environment| 1

Run control after download:

Stop on startup at:

Main
[¥] Verbose log output
["] Use Real Time Access

Launch an invisible winIDEA instance.
Verify after download

main

3

] l Configure...

Workspace file:  DAGH_SW_Projects\DAVE3\dave3110W\V Browse...

}

Q'
Infineon
The debug configuration should contain

the correct project name and elf file.
Switch to the “iSystem Debugger” tab.

Press ->Configure.

Confirm creation a win IDEA workspace
folder and workspace file in the DAVE
project.

=)

W Missing folder

The folder '‘DAGH_SW_Projects\DAVE3\dave3110\WS7_isystem\XMC_2GO_PWM\winIDEA'
doesn't exist do you wish to create it?

Yes

4 |

& New workspace file.

%

winlDEA workspace file specified does not exist - creating it at

DAGH_SW_Projects\DAVE3\dave3110W\WS7_isystem\XMC_2G0_PWM\winIDEA\workspace.
xjrf

e

2014-05-02

Copyright © Infineon Technologies AG 2014. All rights reserved.
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Selecting the MCU target

Main | %3 iSystem Debugger - % Source} S Reﬂeshw 09: Arguments] ] Environmenﬂ =

Run control after download:

Stop on startup att main

Main

[¥] Verbose log outpu .

] Use Real Time Acc Select Hardware Plug-In

Launch an invisible ‘ [ ]
=
V] Verify after downl~ iSYSTEM Development Tools
. 1 Segger Development Tools » 3
Workspace file: DL STMicroelectronics Development Tools VM\wir

[ 0K J ’ Cancel ]

W& WInIDEA Configuration ==l X

Please click item to open configuration dialog.

infineon

winIDEA Open doesn't take the selected device
from the DAVE project, therefore the MCU target
has to be assign once more.

After the winIDEA Open workspace file has been
created the control to “Select Hardware Plug-In”
will appear.

1 Select "Segger Development Tools”.

2 Press ->Select CPU...

3 Select “Infineon” in Manufacturer combo

box.

— Debug E
_2GO_PWM Files For Download...
System Dg D) OfaiET= enﬂ = Common]
Segger
after dow Options..
startup ai 2 Select CPU...
J-Link Maintenance
‘ J-linkInfo
log outpu

SEGGER J-Link V4.80f - Target device settings

=] 4 Select “XMC1100-0064".

Press ->0K.

‘!_l
ul

NE——

| Time Acd

an invisiblg | Manufacturer | Infineon 3 Little endian - | |Coe#0 -

‘ter downl Manufacturer Device Core HumCores Flash size FaM size =

> file: D'\_ Infinean LIMFE120 Cortex-+0 1 248KB 1B KB
Infinean UMF5120 [allaw security) Cortex-t0 1 16KE
Infineon AMC1100-0008 Cortex-t0 1 16 KB
Infingon HMC1100-0016 1 16 KR =

4 SMCTT00.0032 Caries W K

Infineon »MC1700-0064 Cortex-MO 1 16 KB—
Irfinenn HMC1200-0200 Cortes-t0 1 TEKB
Infineon AMC1201-001E Corter-t0 1 1EKR
Infineon AMC1201-0032 Cortex-t0 1 16KB
Infineon AMC1201-0064 Cortex-t0 1 16KB
Infineon RMC1201-M28 Corter-t0 1 16KB
Infineon RMC1201-0200 Corter-t0 1 1EKB
Infineon XMC1202-0016 Cortex-M0 1 16 KB
Infineon AMC1202-0032 Cortex-t0 1 1BKE
< | 1} | ¥

shed bu Select a device for J-Link

Selecting 5 device is not required for mast devices, but allows mare efficient operation of J-Link as well as flash A !
. meaffication of flash mencry cuting = debu session 55 well s unlimited breakpoints in fash memory (Flssh Bre
Build F{| 5
In case of doubt. select the first enty in the list: "Unspecified Device'.
2014-65-02 Copyrignt © Innineon rect

nologies AG 2014. All rights reserved. Page 13



Start the debug session

Debug Configurations

Create, manage, and run configurations

Gfineon

e

Debug - XMC_2GO_PWNITNIZINC = DAVE 3 s —
— — — — — —

iSystem Debug Launcher

L

T -
EEEE IR

Name: XMC_2GO_PWM Debug
type filter text

Main %% iSystem Debugger . 1 Suurce} Eil Reflesh} (ke Alguments] 2] Envirunmenﬂ =] Cummulﬂ
[€11FX GDB Debugging

s Run control after download:
2 iSystem Debugger
= XMC_2GO_PWM D

# TASKING C/C++ Deb|

Stop on startup at:  main

Main

[¥] verbose log output

[]Use Real Time Access

Launch an invisible winlDEA instance.
[¥] Verify after download

Workspace file: D\GH_SW_Projects\DAVE3\dave3110\WS7_isy Browse... l [ Configure...

] 1l [3
Filter matched 4 of 13 items| Apply Revert
@ 1 [ Debug ] [ Close

i1 Press ->Debug in the fully configured

debug configuration to start the debug
session.

Now a build will be started, the image
will be downloaded to the target and a
message to change to the debug
perspective will be prompted. After

confirmation, the debug perspective
will open.

2014-05-02

File Edit Navigate Search Project Debug DAVE Window Help

0~ | G & by & = HESDS e
(¢0)| (= (F)(#H)| com port/!

e Bl S
: 'H Baud Rate 1000000 = & /| = & = G- 0w
## Debug 2 2 = O[t=Variables 2
% ot 14 5 5 Uk |22 2t ES (BB RB~
4 % XMC_2GO_PWM Debug [iISystem Debugger] Name
4 &% iSystem Debugger (30.03.14 19:20) (Suspended)
4 f* Thread [siisystem.eclipse.debug.IConThread, thread id = 1] (Suspended: Brea
|= 1 mainQ Main.c:16 0x10001158 |

< I K
s PWMSP001_0 [€ Main.c 52

int main(veid)

// status_t status; // Declaration of return variable for DAVE3 APIs (

DAVE_Init(); // Initialization of DAVE Apps

while(1)
<] 11l
& Console &

1z Tasks] i] Memorﬂ [¥] Executables] b SFR.ﬂ

CDT Build Console [XMC_2GO_PWM]

2 Press ->Resume in the debug
perspective to run the program.

Copyright © Infineon Technologies AG 2014. All rights reserved.
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Using winIDEA open IDE as debugger @
instead of the eclipse debug perspective

The winIDEA Open IDE provides more comprehensive debug features than implemented in the eclipse CDT

debug perspective. Therefore it might make sense to use this debug user interface instead of the eclipse
perspective.

& Debug Conﬂgurations‘

4 workspace - winlDEA Qe ——
Create, manage, and run configurations File View Project Segger Debug Test Plugins Tools Window Help
iSystem Debug Launcher @ '?ﬂ_o | %] |&' 5z [ = = | 9 j
EEIEER Name. = .GO_PWM Debug 9 Proje_ct Workspa TESEX  Mainc  startup XMC1100s
type filter text [51 Main | %5 iSystem Debugger . &~ Source| & Refresh| ®: Arguments| P8 Environment| = Common = * | Filter \ | B . _
[5] IFX GDB Debuggin = DAGH_SW_Projects\DAVE3\dave3110\WS7_isystemiXMC
99ing Run control after download: = XMC_2GO_P .elf
& iSystem Debugger . Fs | 4 B2 Modules -globl ¥mcl1l100 reset cortex m
¥ XMC_2GO_PWM Debt Smp on startup at:  main — — — - —
4 TASKING C/Cr+ Debuge % +-[3 Types | .type _ X¥mcll00_reset cortex m,
91| Main +-E4 Functions 5 . Xmcll00 reset cortex m:
[] verbose Io-g output B3 +-E£1 Globals .fnstart
[[] Use Real TI-IT\E- -AECESS- ) lﬁ +- B4 Constants
2 71 Launch an invisible winIDEA instance. /* C routines are likely to be cal
[l verity after download s /* This is already setup by BootRO
Workspace file: DAGH_SW_Projects\DAVE3\dave3110\WS7_isystem\XMC_2G Confic @ |— LDR RO,= Xmcll00 stack
f [ MOV SP,R0O
= /* Launch custom pre-program loadi
- i 3 g [ LDR RO,=hardware init hook
< 1l 3 a3
. 4 & /* Branch to the program loader no
@ Debug 3 [ B Xmcl1100 Proaram Loader
= 4 |1
. . . E
1 Open in DAVE the debug configuration |
. - =] :
in the iISYSTEM Debugger tab. -
B
2l
n . .. . L -
2 Uncheck “Launch an invisible winIDEA ® |5 Symbols | % Project
. ” Qutput
instance”. s B

3  Press ->Apply. S User interface of winIDEA Open as separate IDE.

Press the “Run” button to start the program.
If there is no run button the debug controls have
to be enabled: ->View ->Toolbars ->Debug.

4 Press ->Debug to start a debug
session.



| _ (infineon
Further information
B iSystem-EclipseDebugPlugin-UsersGuide. pdf

O http://www.isystem.com/download/eclipse
m iSystem-winIDEA Open extensive Help Menu

O Accessible in the IDE of winIDEA Open

o Help

main.c startup_XM s, @ Contents

2c#include <st|
30

» e ——— ),
}i * supportin| L)
%l 21 = @par | Release Blog (onling)...
22: = THIS SOFT| f
> * OR STATUT| View Examples...
a 24 * MERCHANTA! G
25, * INFINEON o to Forum
b 26 * OR CONSEQ|
27 mmmmmrrnnnn| Support 4
@ 28 Display Option...

@  About winlDEA...

2% Bimmlada mvAL
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